POLARIS RZR

Product Warranty Statement
All products manufactured or distributed by Electronz Ltd are subject to the following,
and only the following, LIMITED EXPRESS WARRANTIES, and no others.
For a period of one (1) year from and after the date of purchase of a new Electronz Ltd
product, Electronz Ltd warranties and guarantees only to the original purchaser that such
a product shall be free from defects of materials and workmanship in the manufacturing
process. A product claimed to be defective must be returned to the place of purchase.
Electronz Ltd, at its sole option, shall replace the defective product with a comparable
new product or repair the defective product.
This expressive warranty shall be inapplicable to any product not properly installed or
properly used by the purchaser or end user, or to any product damaged or impaired by
external forces. This is the extent of warranties available on this product. Electronz Ltd
shall have no liability whatsoever for consequential damages following from the use of
any defective product or by reason of the failure of any product. Electronz Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without
limitation, all warranties of fitness for a particular purpose, warranties of description,
warranties of merchantability, trade usage or warranties of trade usage.
For off-road use only, not intended for highway vehicles.
Electronz Ltd License Agreement
The programme in this system is licensed not sold. Electronz Ltd grants the user a license
for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one
machine at a time. If the programme is transferred a copy of this license and all other
documentation must be transferred at the same time. The license may be terminated by
the user at any time. Electronz Ltd may terminate the licence if the user fails to comply
with the terms and conditions of this license. In either event the copy of the programme
must be destroyed.
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Introduction
Thank you for purchasing your Vi-PEC Plug-In Engine Control Unit (ECU). Vi-PEC i-Series ECUs are an
advanced, fully programmable microprocessor controlled Engine Management System.
The i-Series software platform boasts an impressive list of features giving a new level of user adjustment.
This flexibility allows the tuner to have complete control over the engine management system. i-Series
software employs high resolution fuel and ignition tables with configurable load and RPM centres. When
coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and
intake air temperature correction this gives an unprecedented level of tuning accuracy. All Vi-PEC iSeries ECUs are in field upgradeable, there is no need to return the unit for software updates.
All Vi-PEC i-Series Plug-In Engine Management Systems are designed with flexibility and ease of
installation in mind. Vi-PEC Plug-In systems are designed to either replace the circuit board inside the
factory ECU enclosure, or entirely replace the factory ECU. This provides an invisible install that
requires minimal modification to vehicle wiring and ECU mounting.
Vi-PEC Engine Management Systems are designed with the final result in mind. Not only do they boast
an impressive range of performance features, but are designed with a focus on safety, reliability and
drive-ability. However, the ultimate success of your engine management upgrade is determined by how
well the system is installed and tuned.
Installing and tuning any after market engine management system is not to be taken lightly. i-Series
ECUs give the tuner the control & flexibility that only top after-market engine management systems in
the world can provide. While every effort has been made to keep i-Series ECUs as user friendly as
possible, it should be recognised that added features bring added complexity.
The complete setup of your ECU can be divided into two important tasks:
1. This manual covers the installation of your i-Series ECU. While it is not strictly essential that this
work is performed by an automotive electrician, the knowledge and tools available to these
professionals makes it highly recommended. Regardless of who does the installation, it is of utmost
importance that instructions provided in this manual are followed exactly throughout the installation.
2. Once the i-Series ECU has been installed it will need to be tuned using a laptop computer with iVTS
software. Information on the configuration and tuning of the i-Series ECU is detailed in the online help
section of iVTS. i-Series ECUs are shipped pre-loaded with a base configuration that should be close
enough to get most engines running after a few application specific adjustments have been made.
While hearing the engine running on the new ECU for the first time is always a satisfying feeling, it is
important to realise that the job is not complete. The amount of tuning performed and the experience
of the tuner are the two most important factors in determining how happy you will be with your engine
management system.

1.1

Safety Notice
Your Vi-PEC Plug-In ECU is designed to enhance the performance of your vehicle. However in all
cases, your vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on
public roads. Obey road rules at all times.
WARNING!
Failure to follow all installation and operating instructions may result in
damage to the Vi-PEC ECU, personal injury, or harm to property.

1.2

Disclaimer
All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring
harness are correct. However due to variations between vehicle models it is the installers responsibility
to check wiring connections BEFORE installing the ECU. Vi-PEC will not be held responsible for any
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damage caused by the incorrect installation of this product.

1.3

Support Options
Should any issues arise during installation, the following options exist for technical support:
1. iVTS help, press F1 while running iVTS
2. Contact your nearest Vi-PEC dealer. A Vi-PEC dealer list is available on our website.
3. Vi-PEC website: www.vi-pec.com
4. Technical Support Email: support@vi-pec.com
5. Online Discussion Forum: Available from the Vi-PEC website.
The majority of questions received by the technical support team are clearly answered in the manuals.
To speed up your technical inquiry please consult the manuals to make sure that your question has not
already been answered.
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Pre-Installation
Before installing theVi-PEC i-Series ECU into the vehicle some pre-installation checks must be
performed.

2.1

Staged Injection Upgrade
A staged Injection upgrade is available for the following ECUs.

2.1.1

Polaris RZR XP 900
The Polaris RZR XP900 has an expansion connector which contains connections to injection drives 3
and 4. These two drives can be used for staged injection. See the Polaris RZR XP900 expansion
connector section for pin identification.

2.2

Internal Ignitor

2.2.1

Polaris RZR XP 900 Internal Ignitor
The Polaris RZR XP900 i-Series plug-in ECU is equipped an internal ignitor to meet the requirements of
the factory wiring loom. (This means that ignition coils are wired directly to the ECU).
The internal ignitor can drive 10 amps of current through each ignition channel. It is important not to
exceed this current when setting dwell times or fitting aftermarket coils. Internal ignitors are only present
on IGN 1 and IGN 2
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Installation
This guide provides information on correctly and safely installing your new Vi-PEC i-Series Plug-In ECU.

3.1

ECU Handling Procedures
WARNING!!!
The following installation process will require handling of both the Vi-PEC ECU
and factory ECU. Both of these are highly sensitive to electrostatic discharge
and are easily damaged. Follow the anti-static precautions given in this
manual carefully to avoid damaging electronic components. Warranty claims
for ECUs damaged by electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can reach very
high voltages. Whenever given the opportunity this energy will attempt to discharge
(usually through your finger tips!). This can be fatal to most electronic components. Most
people have experienced an electrostatic discharge when they step out of their car or
touch a metal bench top.
1. The following guidelines describe precautions that can be taken to reduce the possibility
of damaging your ECU:
2. Work only on a conductive surface. A clean steel bench is suitable.
3. Always wear a wrist strap that is electrically connected to the conductive working
surface.
4. Touch the working surface regularly.
5. Do NOT touch components on the circuit board.
6. Where possible, only handle the ECU by its plastic header.
7. Do NOT carry the ECU around without anti-static packaging.
8. Do NOT touch the bare terminals in the ECU header.
Observing the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

3.2

Fitting the ECU
Information is provided to assist in fitting the ECU into the vehicle.

3.2.1

Fitting a Polaris RZR ECU
Ensure you are following the given anti-static guidelines. The following steps outline the installation
procedure:
1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position before proceeding.
The factory ECU is located behind the left hand seat. Unplug the wiring connectors from the factory
ECU and remove any mechanical fasteners holding the ECU in place. DO NOT touch the exposed
© 2013 Vi-PEC
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pins in the factory ECU connector. Remove the factory ECU from the vehicle and place it to one side.
2. Install the Vi-PEC ECU into the factory ECUs position. Reinstall any fasteners.
3. Connect the wiring loom to the Vi-PEC ECU, note that the ECU connector will have to be rotated from
the factory position to suit the Vi-PEC ECU.
4. Make sure the ECUs internal MAP sensor has been connected. See the MAP sensor section of this
manual for details.
5. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual
first.
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Additional Sensors
i-Series Plug-In ECUs offer various options for the installation of additional sensors and devices. As a
minimum it is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP)
sensor and Intake Air Temperature (IAT) sensor. These parts can be purchased if required from your
nearest Vi-PEC dealer.

4.1

MAP Sensor
It is important that the pressure source for a MAP sensor be taken from a stable pressure source after
the throttle body. It is common to 'T' into the fuel pressure regulators pressure signal. Do NOT share
this signal with other devices such as boost gauges or blow off valves.

4.1.1

Polaris RZR XP900
To ease installation the i-Series Polaris RZR XP900 ECU is fitted with an internal MAP sensor. This
sensor is rated to 4.0 Bar absolute pressure (3.0 Bar of boost). The internal MAP sensor is wired to An
Volt 3.
Make sure that the correct An Volt channel has been selected as MAP sensor in iVTS and a MAP
calibration has been performed before attempting to start the vehicle.

4.2

IAT Sensor
It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction
of fuel and ignition based on the engines air charge temperature.
An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is
not recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

4.2.1

Polaris RZR XP900
From factory, the Polaris RZR XP900 has a factory IAT sensor wired to AnTemp 2.

4.3

Expansion Connector
The expansion connector is provided to allow easy connection of additional ECU inputs. An “expansion
cable” needs to be purchased from your Vi-PEC dealer.
Important points when wiring to the expansion connector:
Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V out signal
also provides power for other sensors.
Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

4.3.1

Polaris RZR XP 900 Expansion

© 2013 Vi-PEC
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Looking into ECU side connector

Pin
Function
Number
1
CAN H
2
Auxiliary Output 9
3
4
5
6
7
8
9
10
11
12

Auxiliary Output 4
Injector Drive 4
Injector Drive 3
+5V
CAN L
Digital Input 5
Knock 1
AN Volt 5
AN Temp 3
Sensor GND

Notes
Communication bus
Maximum current of 2 amps
when driving to GND
Maximum current of 2 amps
when driving to GND
Maximum current of 5 amps
Maximum current of 5 amps
For sensors only
Communication bus
Digital Input
Knock sensor input
Analog 0-5V input
Temperature Sensor Input
For sensors only

Part numbers for expansion connector plug:
Connector - MX23A12SF1
Retainer - MA23A12Xf1
12 x Terminals - M23S05K351.
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PC Tuning
i-Series ECUs require PC/laptop tuning using the iVTS Tuning Software application running on a
Windows based computer. iVTS may be downloaded from www.vi-pec.com. Note that when new
versions of iVTS are released they are posted on the website and may be downloaded at no cost. Also
note that i-Series ECUs must be used with the correct version of iVTS.
IMPORTANT!
The i-Series ECU has on board USB.
BEFORE connecting the ECU to your laptop, the USB drivers must be
installed. Failure to install the drivers on your laptop first may result in
windows assigning incorrect drivers. These drivers will not work with the iSeries ECU and are difficult to uninstall. The correct USB drivers are installed
as part of iVTS installation, as described in the following section. Should
internet download not be practical, a copy of the drivers on CD can be
obtained from your nearest Vi-PEC dealer.

5.1

Installing iVTS
Due to the frequent updates iVTS is no longer shipped with each ECU. You will be required to download
the latest version of iVTS from: www.vi-pec.com
Should access to an Internet connection be impractical, the latest version of iVTS can be requested from
your nearest Vi-PEC dealer on CD.
Installing from the web
1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of iVTS. When prompted to run or save the file, select save. It is
recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes. This may take some time.
5. When installed, open iVTS by double clicking on the icon that has been placed on the desktop.
Installing from a CD
1.
2.
3.
4.
5.
6.
7.

5.2

Insert the iVTS disk into you computer’s CD ROM drive.
Open 'My Computer'
Double click your CD ROM drive.
Double click the file labelled iVTSSetup.exe (or similar name).
Follow the on screen instructions.
When prompted to install USB drivers, select yes. This may take some time.
When installed, open iVTS by double clicking on the icon that has been placed on the desktop.

Communicating With Your ECU
After iVTS installation, you will be able to connect the i-Series ECU to the laptop to perform set-up and
tuning work.
1. Connect the ECU to your laptop using a Vi-PEC i-Series ECU USB Cable. If not supplied with the
ECU, these can be purchased from a Vi-PEC dealer. No other adapter or cabling is required.
Connect the cable to the connector labelled USB.
2. If this is the first time you have connected a i-Series USB ECU to your laptop follow the driver
installation instructions that appear. When prompted if you want to install drivers select 'Continue
Anyway'.
3. Start iVTS by double clicking on the iVTS icon on the windows desktop.
4. Switch the key to the ON position. This will provide power to the ECU.
5. In iVTS, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.
Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.
6. iVTS offers both mouse and keyboard control. To establish a connection between the PC and ECU
© 2013 Vi-PEC
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press the F3 key. The same process can be used to disconnect. If a successful connection is
established, iVTS will download settings from the ECU, otherwise you will be warned that an error has
occurred.
7. Make sure the connection shows “ONLINE” in the top right corner of iVTS.
8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning
the ECUs power off all changes made will be lost.
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Pre-Start Configuration
Before starting the vehicle, important pre-start configurations need to be made.

6.1

Firmware Version
It is recommended that the Vi-PEC i-Series ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with iVTS and selecting 'ECU Information'
under the Help menu.
The latest firmware can be downloaded from our website with iVTS.
It is recommended that this is performed by an experienced Vi-PEC dealer as new features may need to
be properly configured.
The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in iVTS.
Follow the on screen instructions to complete the firmware update process.

6.2

Base Configuration
All i-Series Plug-In ECUs are shipped with base configuration settings. Note that these are provided to
reduce initial setup and tuning times. They are NOT recommended tuning values. iVTS includes base
configurations for various models. Download the appropriate base configuration into your ECU with iVTS
by connecting to the ECU (described in the Connecting To iVTS section of this manual), then selecting
'Open' under the 'File' menu. Select the appropriate .pcl file and then select 'Open'. Downloading large
configuration files can take up to a few minutes. Be patient and acknowledge any messages iVTS
shows.

6.3

MAP Sensor Calibration
At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match
the Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP
sensor also allows the MAP sensor to be calibrated prior to tuning.
Vi-PEC i-Series ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This
ensures that all iVTS Tuning Software programs (pcl Files) give a consistent state of tune throughout the
ECU range. This allows a PCL file to be transferred between i-Series based ECUs giving an equivalent
state of tune providing all factors affecting volumetric efficiency are equal.
Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be
significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge
Pressure (MGP) as a load index.
To calibrate the MAP sensor:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.
2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP
sensor. Select the correct MAP Sensor Type.
3. Under the 'Options' menu, select 'MAP sensor calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).
6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
7. Perform a 'Store' by pressing F4.

6.4

TPS Calibration
The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management
parameters used by functions such as idle speed control,acceleration enrichment and motor sport
© 2013 Vi-PEC
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features. It is important that the ECU knows when the throttle is open and closed (or part way in
between). The following procedure calibrates the ECU to match the TPS:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.
2. Under the Analog Channels menu, ensure that the correct An Volt channel is set to 'TPS (Main)'.
Refer to the pin functions section of this manual for details.
3. Under the 'Options' menu, select 'TPS calibration'.
4. Follow the on screen instructions.
5. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).
6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.
7. Perform a 'Store' by pressing F4.

6.5

IAT Sensor Selection
This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the
intake system. It is important that the ECU is calibrated to match the sensor installed in the engine.
This procedure is as simple as selecting the correct sensor type as follows:
1. Connect a laptop/notebook PC to the ECU and connect to the ECU using iVTS.
2. Click on 'Analogue Channel' in the configuration tree.
3. Select the An Temp channel the sensor has been wired to.
4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.
5. Select the correct 'Temp Sensor Type'.
6. Select the 'Analog Inputs' tab in the runtime values section of iVTS (lower part of the screen).
7. Ensure that IAT reads the correct temperature.
8. Perform a 'Store' by pressing F4.

6.6

Input and Output Setup
As the Vi-PEC i-Series Plug-In ECUs are designed to run several models there are a few items that
must be set-up to make the ECU specific to your model.
The Pin Functions section of this manual gives a list of the functions of each channel based on the
target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:
All Auxiliary Output Channels
Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.
All Digital Inputs
Look at the Digital Inputs runtime values (lower section of the iVTS screen) to confirm each channels
operation.
All Analogue Volt and Temperature Inputs
Look at the Analogue Inputs runtime values (lower section of the iVTS screen) to confirm each channels
operation.

6.7

Trigger Calibration
The following instructions assume that all pre-start set-up instructions given in previous sections have
been completed. Only after all pre-start checks have been made should an attempt be made to crank
the engine. The following steps must be performed before an attempt is made to start the engine to
ensure the i-Series ECU is calibrated to precisely measure engine position.
1. Connect the ECU to iVTS.
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2. Select 'Fuel', then 'Fuel Set-up':
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the iVTS
online help (Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement of engine
timing is usually made. Also it is often harder to see timing marks with a timing light at slow engine
speeds. Trigger calibration should be checked again at between 2000-4000 RPM where engine speed is
stable and a more consistent timing reading can be obtained.
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First Time Startup
After performing all set-up instructions given in previous sections, including trigger calibration, the engine
is now ready to be started. The following procedure should be used for first time start-up.
1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.
2. Connect the ECU to iVTS.
3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:
a. TPS – spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration.
b. MAP – should read approx 101 kPa (at sea level) with the engine not running. If not, check the
MAP Sensor Type setting and perform a MAP Calibration.
c. ECT – should read current engine temperature.
d. IAT – should read current intake air temperature.
e. Digital Inputs (click the 'Digital' tab) – Operate switches connected to any digital inputs while
watching the runtime value to ensure they operate as expected.
4. Rectify any faults found in Step 3.
5. Locate the 'Master Fuel' setting. This can be found in the ECU Settings Menu under: Fuel > Fuel
Setup > Fuel Main.
a. This will need to be adjusted during or just after start-up.
6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning. If necessary adjust the Master setting to enrich/lean the engine (increase to enrich).
7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.
8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count
one or two on the first engine revolution.
9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best possible
running.
10.The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don’t forget to keep an eye on engine temperature.
11.Once the engine is warmed up and running well, perform another trigger calibration (known “as setting
the base timing”).
12.Perform a Store by pressing F4.

7.1

Final Checks
To avoid potential engine damage and wasted time, the adjustments presented in the following sections
must be made before attempting to start the engine.
For further help on any of the settings discussed below, consult the online Help in the iVTS Tuning
Software. Online help can be invoked by pressing F1, or right clicking any item and selecting ‘What’s
this?’.
Pre-set-up Checks
Before attempting to configure the ECU, ensure the following tasks have been completed:
1. Ensure the ECU and all associated components are connected and correctly wired/installed.
2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during the set-up
procedure.
3. Check all oil and water levels are correct.
Connecting to iVTS Tuning Software
Use the following procedure to establish a connection between your Vi-PEC ECU and iVTS Tuning
Software tuning software.
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1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to iVTS Tuning Software as described in the
'Communicating with your ECU' section of this manual.

7.2

Essential Tuning Adjustments
It is assumed that at this stage all set-up procedures described in previous sections have been
completed and the engine is running. The following steps detail correct set-up procedures for some of
the more critical ECU parameters (note that MAP Sensor Calibration should have already been
completed by now):
Injector Voltage (Dead-time) Correction
There is always a delay between the injector being energised and the injector actually opening.
Likewise, there is a small delay between the injector being de-energised and the injector closing. The
opening time is considerably longer than the closing time, however the overall result is that less fuel will
flow for a given pulse width than would be expected with an 'ideal injector'. To compensate for this the
injector pulse widths are increased to compensate for this 'dead-time'. The dead-time for a given injector
is a function of the battery voltage, differential fuel pressure and the type of injector driver (saturated or
peak and hold). A typical dead-time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms
= millisecond = 1 thousandth of a second).
In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only
variable that is changing will be the battery voltage (this changes with electrical load and sometimes
engine speed). Without correction, the changes in dead-time will cause the engine to run lean when the
voltage drops. If the Injector Voltage Correction is properly set-up then changes in the battery voltage
will not affect the air/fuel ratio.
The injector dead-time table allows the dead-time for different battery voltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system voltage.
Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.
To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set voltage. Vary the
supply voltage to the injector and measure minimum pulse width at which the injectors will flow for a
particular voltage. This is the required dead-time for that injector at that tested voltage.
To determine injector dead-time on a running engine, with the engine fully warmed and operating at
stable air/fuel ratios (a very precise AFR meter is required – a narrow band O2 sensor will not suffice),
electrical drain needs to be applied to the system; the preferred method is disconnecting the alternator
main fuse. Battery load testers are also useful here too.
Watching the air fuel ratios change while the battery voltage drops, the dead-time table can be trimmed
to maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth
curve needs to be maintained at all times.
NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.
Master
Master should be set so that the numbers in the middle of the fuel table end up around a value of 50.
This is to allow sufficient span of the numbers in the main fuel table.
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Pin Functions
A list of pin functions is provided, this is useful when configuring your ECU through iVTS.

8.1

Polaris RZR XP900
Polaris RZR XP900 V1.0
Auxiliary Outputs
Aux 1

Fuel Pump Relay

Aux 2

Engine Fan

Aux 5

ISC Stepper

Aux 6

ISC Stepper

Aux 7

ISC Stepper

Aux 8

ISC Stepper

Aux 9

Expansion Connector

Aux 10

Expansion Connector

Aux - Injection Outputs
Aux Inj 3

Expansion Connector

Aux Inj 4

Expansion Connector

Aux Inj 5

EFI Relay

Aux Inj 6

AWD Hub Coil

Analog Channels
An Volt 1

Factory MAP signal (Atmospheric pressure only)

An Volt 2

Throttle Position Sensor

An Volt 3

Internal MAP Sensor

An Volt 4

Transmission Position Sw itch

An Volt 5

Expansion Connector

An Temp 1

Engine Coolant Temperature

An Temp 2

Intake Air Temperature

An Temp 3

Expansion Connector

Digital Inputs
DI 1

Ignition Sw itched 12v+

DI 2

Vehicle Speed

DI 3

AWD Sw itch

DI 4

Input for equipment not fitted to all models

DI 5

Expansion Connector

Knock Inputs
Knock 1
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Pinouts
Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire
side).

9.1

Polaris RZR XP900

Looking into the ECU side connector

Pin
2
4
5
9
10
16
17
19
22
23
24
25
26
28

ECU Function
Inj 5
Aux 2
Inj 1
DI 1
An Volt 2
Inj 2
Inj 6
Aux 1
An Volt 1
An Volt 4
An Temp 2
Aux 6
Aux 7
DI 3

Pin
32
36
37
38
39
44
45
48
54
55
56

ECU Function
DI 4
CAN 2 High
Aux 5
Aux 8
Trig 1
An Temp 1
DI 2
CAN 2 Low
Aux 3
Ign 1
Ign 2
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CAN Information
The following CAN (Controller Area Network) information is provided:

10.1

Polaris RZR XP900 CAN
The Vi-PEC Polaris RZR XP900 ECU does not receive any information over the CAN bus, it does
however transmit information to other devices on the CAN bus.

10.2

Toyota Altezza SXE10 CAN
The Vi-PEC i-Series Altezza SXE10 ECU contains a CAN to BEAN (Body Electronics Area Network)
converter. This allows the ECU to transmit and receive information with other devices in the vehicle.
Information transmitted by the Vi-PEC i-Series ECU:
Engine Speed
Engine Coolant Temperature
Ambient Air Temperature
Battery Voltage
Air Conditioning Request
'Snow' button
Alternator Light
Information received by the Vi-PEC i-Series ECU:
Air Conditioning Request
'Snow' button
The Vi-PEC ECU uses its 'CAN 2' communication bus to communicate with the other devices in the
vehicle. When first receiving your Vi-PEC i-Series Altezza ECU the CAN 2 (BEAN) will be set up
already.
Should something change and you need to restore the CAN 2 (BEAN) setup to original, complete the
following steps:
1. Connect your laptop to your ECU with the USB communications cable and turn the ignition to the ON
position.
2. Start iVTS for i-Series and press F3 to connect to the ECU. When the ECU is connected the status
bar in the top right corner will be green.
3. Select ECU Controls > CAN Setup.
4. Select the Module CAN 2, set the Mode to 'User Defined' and the Bit Rate to 1 Mbit/s.
5. Now select CAN Channel 1 and configure its mode to 'Transmit User Stream 1', set the ID to 88, the
Format to Standard, and the Transmit Rate to 20 Hz.
6. Next select CAN Channel 2 and configure its mode to 'Receive User Stream 2', set the ID to 89 and
the Format to Standard.
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7. Change to the Streams tab of the CAN Setup window
8. Select Stream 1 and click the 'Load Stream' button. Navigate to your iVTS install directory and select
the CAN sub-directory, choose 'Link - Vi-PEC Altezza Plug-in Transmit' and click the Open button.
9. Select Stream 2 and click the 'Load Stream' button. Navigate to your iVTS install directory and select
the CAN sub-directory, choose 'Link - Vi-PEC Altezza Plug-in Receive' and click the Open button.
10.Click the Apply button and then the OK button
11.Press F4 to perform a 'Store' upon your ECU.
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Known Issues
All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often variations that
have not been tested. For this reason issues can arise.
WARNING: Always download the latest Installation Manual from vi-pec.com and check the latest status
of known issues before installing the ECU.
Please contact your nearest Vi-PEC dealer when suspecting a compatibility issue.

11.1

Polaris RZR XP900
There are currently no known issues.
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